
How to Prep Digital Art Files for Printing

Prepress Guide
The following pages are designed to help you set up your artwork  
for the most successful print. Please refer to this document before 
sending art files to ensure proper setup and a smooth approval process.
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LABEL

SILK PRINT

Resources:
InDesign: Packaging files for handoff

We recommend:
•  Vector format file (.pdf, .eps, or .ai) 

Files created using a vector application will yield the best results.

We accept:
•  Adobe InDesign (.indd) 

Remember to include all fonts and support files.

•  Raster format file (.jpg, .tif, and .psd) 
If image resolution is appropriate this format should be fine, but edits are often difficult.

1. File Format
Graphic Designers often use Adobe® Illustrator® (Ai) and Adobe® InDesign® (Id) to produce 
beautiful vector artwork. Adobe® Photoshop® (Ps) can support vector art, but does not  
offer a reliable vector export option. Photoshop is mainly used as an image editor for  
raster images.

LABEL ONLY

2. Image Resolution 
Combining raster (photography) with vector artwork to your 
label is a great way to maximize visual impact, but you need to 
make sure the image is high-quality when the file is saved. Adobe 
Illustrator allows you to do this through its Raster Effects feature 
where image resolution can be set.

These settings can be found in Adobe Illustrator’s Effect  
dropdown menu.

We do dot recommend using raster elements for silk print projects.

We recommend:
•  300 Effective PPI (aka: Dots Per Inch - DPI) 

Remember that an image’s resolution will change when scaled within your layout.

•  Color Mode (CMYK or Grayscale) 
The appropriate color mode should be used for the desired effect.

•  Cropping Images 
Images should be cropped close to the size they’re used to help reduce the file.

We accept:
•  Images higher than 300 Effective PPI 

Excessive resolution does not result in a higher quality image.

https://helpx.adobe.com/indesign/how-to/indesign-package-files-for-handoff.html
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3. Screens and Gradients
If your artwork uses screens and gradients, it’s important to consider how they will reproduce 
on your container.

4. Dot Gain and Ink Spread
Dot Gain and Ink Spread can be avoided if you set up your labels correctly.

LABEL

LABEL

SILK PRINT

SILK PRINT

If steeping occers in Adobe Photoshop we recommend:
•  Add a slight “Noise” (Ps: Filter> Noise> Add Noise) to color gradients 

This will help eliminate screen stepping in blends.

If steeping occers in Adobe Illustrator we recommend:
•  Add a slight “Film Grain” (Ai: Effect> Artistic> Film Grain) to color gradients 

This will help eliminate screen stepping in blends.

We recommend:
•  Avoiding Screens and Gradients because they will not reproduce well 

Best results come from using solid colors.

Be cautious:
•  When dealing with small type and fine details that may fill in or spread during the  

Silk Printing process.

If labels are produced by a “Digital” press:
•  Minimal, if any, Dot Gain or Ink Spread may occur

If labels are produced by an “Offset” press:
•  Colors may appear slightly darker between the film and the printed piece
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LABEL
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We recommend:
•  Process color (CMYK) 

Process color will produce the best results.

•  One-color black 
Try to avoid including additional colors (cyan, magenta, and yellow) when using 100% black.

We accept:
•  RGB color 

Not recommended due to unacceptable results when converted to process color.

We recommend:
•  Spot color (PANTONE®) 

Pantone matching system provides hundreds of spot colors to choose from.

•  Include white “Under Base” layer when needed 
This will give your color more “pop.”

We accept:
•  CMYK & RGB color 

Files with these colors will require editing.

5. Color
Our labels are typically produced by digital printers using process color, which combines  
cyan, magenta, yellow, and black (CMYK) to produce most colors. If you have a specific 
PANTONE® color you’re trying to match it can be converted to process color by most  
graphic design applications.

Silk Printing uses solid colors from the PANTONE® spot color library. When printing multiple 
colors with silk printing, keep in mind there may be a variance of 1/16’’ between spot colors.

Resources:
Ode to Lawrence Herbert and his PANTONE color system

https://www.pantone.com/
https://www.pantone.com/
https://www.containerandpackaging.com/resources/ode-to-lawrence-herbert-and-his-pantone-color-system/
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We recommend:
•  Convert all text to outlines 

Ai & Id: Type> Create Outlines.

•  Fonts should be no smaller than 4pt (Medium font style) 
Also, go easy on the copy. A label is not the place to put your doctoral dissertation.

•  Use caution when using “Light” and “Thin” typefaces with small point sizes (~5pt) 
Print out your label scaled at 100%.

•  Avoid “Reversed” text on small text (~5pt) 
This will reduce the chance of enclosed spaces from filling in.

We accept:
•  Editable text (not outlined) 

Please include the actual font files (.otf or .ttf) with your art files.

We recommend:
•  Convert all text to outlines 

Ai & Id: Type> Create Outlines.

•  Fonts should be no smaller than 6pt (Medium font style) 
Also, go easy on the copy. A label is not the place to put your doctoral dissertation.

•  Use caution when using “Light” and “Thin” typefaces with small point sizes (~7pt) 
Print out your label scaled at 100%.

•  Avoid “Reversed” text on smal text (~7pt) 
This will reduce the chance of enclosed spaces from filling in.

We accept:
•  Editable text (not outlined) 

Please include the actual font files (.otf or .ttf) with your art files.

6. FONTS
There are thousands of fonts on the internet. Some require you to purchase usage  
rights while others may be free. Please check your font usage rights early in the  
design process.

It’s unlikely we have the same typeface, version, or even the rights to the font you’re using. 
The best way to avoid any issues is to convert all your text to outlines before providing 
final artwork. By doing this, text will be converted to a non-editable element (vector) and 
no longer require the font to be loaded. Keep in mind that once this is done text edits will 
be difficult if changes are needed. A common practice is to keep an original version before 
creating a version with outlined text.

We recommend printing your label out at actual size to ensure your text appears as intended.

LABEL

SILK PRINT
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7. Stroke/Rule Thickness
If you have strokes/rules in your artwork you should use caution when using thin lines to 
avoid dissapearing when printed.

We recommend:
•  At least .5pt thick, and at least 1pt thick when over black backgrounds (reversed) 

We recommend:
•  At least 1pt thick, and at least 2pt thick when over black backgrounds (reversed) 

LABEL

SILK PRINT

8. UPC CODE
Consider the color of your container, product and ink when using 
barcodes. Printing a barcode on a dark container may require a 
white background or you may consider reversing the barcode.

Resources:
Get Started Guide
How to silk print barcodes and make them scannable
Cracking the Barcode Encryption

We recommend:
•  At least 1” wide 

Please confirm they work as intended if they are used smaller than 1” wide.

•  Black barcode on a white field 
This will be the most successful.

We accept:
•  Reversed (light color over a dark background) 

Please test before providing final artwork.

SILK PRINT

LABEL

https://www.gs1us.org/upcs-barcodes-prefixes/get-started-guide
https://www.containerandpackaging.com/resources/how-to-silk-print-barcodes-and-make-them-scannable-2/
https://www.containerandpackaging.com/resources/crackingthebarcodeencryption/
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9. Margins & Bleeds
These need to be considered so critical content avoids being cut-off during the  
printing process.

We recommend:
•  Keep all critical text and graphics at least 1/8” from the trim edge

•  Include at least 1/8” bleed

We accept:
•  Content 1/16” from trim edge 

Although not recommended, critical content should not come within 1/16” from trim edge.

We recommend:
•  Print out your art and adhere it to your sample container 

This is a great way to verify your artwork looks as expected.

We recommend:
•  Avoid printing within 1/8” of container seams 

Most containers have mold seams that may impact how artwork prints over them.

•  Print out your art and adhere it to your sample container 
This is a great way to verify your artwork looks as expected and avoid container seams.

We accept:
•  Content that crosses over container seams 

Be aware that content may “smudge” when content crosses over container seams.

We recommend:
•  Keep content 1/8” from the right and left edge 

This will ensure your artwork will print clearly.

•  Avoid placing content within the squeegee lift area  
Silk Printing needs 1/8” of free space on the left side to operate correctly.

•  Do not extend content beyond the maximum dimension 
Since Silk Printing is applied directly to a container, bleeds are not necessary.

SILK PRINT

SILK PRINT
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Resources:
How to Make the Perfect Label

10. Wraps and Panels
A wrap refers to how a label “wraps” around a container, and a panel is the “side” of the  
label that can been seen without having to rotate the container when applied. 

Only about 30% of the container can be visible at any one time. Keep this in mind when 
designing your label so panel content is visible without turning the container.

https://www.containerandpackaging.com/resources/infographic-8-point-checklist-to-making-the-perfect-label-2/
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11. Templates and Dielines 
Some of our print partners require artwork built using their templates. In these cases, your 
Container and Packaging consultant will provide a template for your designer to use. We also 
offer templates, for both label and silk printing, for all of our containers on our website.

We recommend:
•  Verify the template fits your container correctly 

Your container may have a slight taper, so labels may need to be designed with that in mind.

For Clear labels we recommend:
•  Include a “white base” layer under all content you don’t intent to appear clear 

This acts as a “primer base” to help your colors pop.

For Chrome labels we recommend:
•  Include a “white base” layer under all non-metallic content 

This acts as a “primer base” to cover the chrome substrate.

We recommend:
•  Verify the template fits your container correctly 

Your container may have a slight taper, but this process can accommodate for small tapers.

SILK PRINT

LABEL

LABEL ONLY

12. Clear and Chrome Labels
Colors will appear dull on clear labels if a “white base” is not included. The “white base” will 
be printed below the rest of the colors to help your colors appear more vibrant. 

Labels on a chrome substrate also require a “white base” everywhere the metallic appearance 
should be blocked out. This will allow the areas without a “white base” to have a colored 
metallic appearance. 

Artwork should include this “white base” as a separate layer, indicated as 100% magenta, 
everywhere white should be printed for non-metallic areas.
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13. Review / Confirm
Print it out and try it on. You’ll be amazed at how many problems you’ll catch if you do this 
simple trick. Print your label out at actual size (double check that Adobe Acrobat does not 
have “Shrink to page” selected) on any printer, cut it out, and tape it to your container. You’ll 
quickly see that your front panel is too wide, your text is too small, your label doesn’t fit, the 
wrap doesn’t line up, etc.

We recommend:
•  Proofread your content 

Check for spelling, proper instructions, correct ingredients and legibility. You’ll be glad you did.

•  Print-out your art and place it on your container 
This is a great way to confirm your label looks as you expected.

•  Does your container have tapered walls? 
Double-wall jars may not look like they have tappered walls but most do (~1/2 degree).

SILK PRINT

LABEL

14. Submit
The last step is to have someone check your art and make sure that it’s going to print 
successfully. The last thing that you want to do is print hundreds of labels and find they 
aren’t the right size, the image is fuzzy, the text is too hard to read, or the color is off. Pay 
the nominal fee to have your art checked by our Studio, and you can move forward with the 
assurance that you haven’t made any mistakes. We wish you the best of luck with preparing 
art files for label printing.

15. Celebrate
Behold, the finished product. A quality label on a quality container is a quality thing.

We recommend:
•  Clearly name your files 

This is helpful when product lines that have several types, and/or sizes

We recommend:
•  Do a happy dance 

Don’t worry... nobody is looking.

•  Buy donuts for the office 
Let eveyone share in your achievement of a beautifully designed container.
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